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AÇIKLAMALAR 
ALAN  Grafik ve Fotoğraf 

DAL/MESLEK Grafik Operatörü  

MODÜLÜN ADI  Vektörel Çizim  

MODÜLÜN TANIMI  

Vektörel çizim programında geometrik form çizimleri ve 

yüzeyde düzenleme çalışmalarının yapıldığı öğrenme 

materyalidir. 

SÜRE 40/24 

ÖN KOŞUL 
Temel Tasarım Dersi ve Temel Yazı, Yazı Düzenlemeleri 

modüllerini başarmış olmak 

YETERLİK Bilgisayarda temel düzenlemeler yapmak  

MODÜLÜN AMACI 

Genel Amaç  

Bu modül ile gerekli ortam sağlandığında vektörel çizim 

programında geometrik formları tasarı ilkelerine göre 

düzenleyebilecek ve basit metinler oluşturabileceksiniz. 

Amaçlar  

 

1. Vektörel çizim programında geometrik form çizimlerini 

yapabileceksiniz. 

2. Geometrik formları tasarı ilkelerine göre 

düzenleyebileceksiniz. 

3. Vektörel çizim programında basit metin 

oluşturabileceksiniz. 

EĞİTİM ÖĞRETİM 

ORTAMLARI VE 

DONANIMLARI 

Ortam: Grafik atölye ve laboratuvarları, aydınlık ve 

pencereleri sola bakan geniş sanatsal mimariye sahip sınıflar, 

işletme, kütüphane, ev, bilgi teknolojileri ortamı vb.  

Donanım: Bilgisayar, tarayıcı, yazıcı, çizim masası, ışıklı 

masa, amblem arşivi CD’leri, İnternet, dergi ve mecmualar, 

projeksiyon vb. 

ÖLÇME VE 

DEĞERLENDİRME 

Modül içinde yer alan her öğrenme faaliyetinden sonra 

verilen ölçme araçları ile kendinizi değerlendireceksiniz. 

Öğretmen modül sonunda ölçme aracı  (çoktan seçmeli test, 

doğru-yanlış testi, boşluk doldurma, eşleştirme vb.) 

kullanarak modül uygulamaları ile kazandığınız bilgi ve 

becerileri ölçerek sizi değerlendirecektir.  

AÇIKLAMALAR 
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GİRİŞ 
 

Sevgili Öğrenci, 

 

Vektör; doğrultusu, yönü ve uzunluğu olan, koordinat düzleminde başlangıç ve bitiş 

noktası belirlenmiş doğrulardır. Çözünürlükten bağımsız olarak büyültülüp 

küçültüldüklerinde kalitelerinde bir değer kaybı olmaz. Bu özelliklerinden dolayı logo, 

logotype tasarımında, yazılı ve görsel reklam sektöründe kullanılmaktadır. 

 

Hazırlanan bu modülde vektörel çizim programında çizim ve boyama araçlarının 

yanında bilgisayar destekli uygulamalar da ele alınacaktır. Vektörel Çizim modülünde 

istediğiniz görselleri bilgisayar yardımıyla oluşturacaksınız.  

 

Modülü başarı ile tamamladığınızda vektörel programda geometrik form çizimlerini 

yapacak ve geometrik formları tasarı ilkelerine göre düzenleyebileceksiniz. Vektörel çizim 

programını öğrendikten sonra çalıştığınız alanda yapacağınız tasarımları rahatlıkla bilgisayar 

ortamına aktarabileceksiniz. 

GİRİŞ 
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ÖĞRENME FAALİYETİ–1 
 

 

 

Bu faaliyette verilecek bilgiler doğrultusunda uygun ortam sağlandığında vektörel 

çizim programında geometrik form çizimlerini yapabileceksiniz. 

 

 

 

 

 
 Vektörel çizim ile ilgili basılı ve görsel kaynakları inceleyiniz. 

 Vektörel çizim ile ilgili uygulamaları inceleyiniz. 

 

1. VEKTÖREL ÇİZİM PROGRAMI 
 

İllüstrasyonun kelime anlamı; resimleme, kısaca izleyiciye yansıtılmak istenen bir 

konunun veya betimlenmek istenen bir olayın görsel olarak anlatılması olarak açıklanabilir.  

 

Dijital illüstrasyon, kullanıcıların istedikleri görselleri bilgisayar yardımıyla 

oluşturmasıdır. Görseller bilgisayar ortamında resimsel veya vektörel olarak oluşturulur.  

 

 

Resim 1.1: Dijital illüstrasyona örnek  

ÖĞRENME FAALİYETİ–1 

AMAÇ 

ARAŞTIRMA 
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Vektör grafiği doğrultusu, yönü ve uzunluğu belli olan koordinat düzleminde 

başlangıç ve bitiş noktası belirlenmiş doğrulardır. Matematiksel ifade oldukları için 

çözünürlükten bağımsız olarak büyütülüp küçültüldüklerinde kalite kaybetmez. 

 

 

Resim 1.2: Elmanın fotoğrafı ve vektörel çizimi  

 

1.1. Programı Açma 
 

Bilgisayarınızda vektörel çizim programına çift tıkladığınızda program aşağıdaki 

ekran ile açılır. Bu ekranın sol üst tarafında önceden çalıştığınız dosyaları görebilir veya 

buradan yeni bir dosya açabilirsiniz.  
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Resim 1.3: Karşılama ekranı 

 

1.2. Yeni Belge Oluşturma 
 

Ekranınızın sol üst köşesinde bulunan “File” sekmesinin alt seçeneklerinden biri olan 

“New”i tıklayarak ya da PC’ler için "Ctrl+N"; Mac’ler için "Command+N" ye tıklayarak 

yeni bir çalışma alanı açmak için size yardımcı olacak pencereye ulaşabilirsiniz.  

 
 

 Name: Çalışma dosyanıza isim verebileceğiniz kısımdır. Yaptığınız işin 

amacına uygun olarak isim vermekte fayda vardır. Buraya bir isim yazdığınızda 

en üstteki mavi alanda bu isim görülecektir. İsim vermediğiniz takdirde 

“Untitled” (Başlıksız) olarak görülecektir. Dosya ismi kaydederken de 

verilebilir.  
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Resim 1.4: Yeni belge oluşturma penceresi 

 

 New document profile: Hazır doküman profillerini elde edebileceğiniz 

kısımdır. Bu profiller, çalışma alanı boyutlarının, çözünürlük değerlerinin yanı 

sıra renk modu değerlerini kapsar. Print baskıda kullanılacak çalışmalar için 

Web, Mobile and Device, Video and Film, dijital ortamlar için geçerlidir. 

 

 Size: A3, A4 vb. standart “ISO (International Standartization Organization)” 

kâğıt ölçülerinin doğrudan seçilebilmesini sağlar. 

 

 "Width" (genişlik) "height" (yükseklik): Dokümana standart dışı 

ölçülendirme yaparak en ve boy ölçüsünü klavye ile girmeyi sağlar. 

 

 Units: Çalışmanızda baz aldığınız ölçülendirme birimi olarak bilginizi 

girebileceğiniz alandır ki ülkemizde “metrik sistem” (mm, cm) 

kullanılmaktadır. 

 

 Orientation: Çalışma alanınızın (Kâğıt gibi düşünmelisiniz.) yatay ya da dikey 

olma özelliğini belirlediğiniz kısımdır. 

 

 “Advanced” yazısının hemen yanındaki oka tıkladığınızda açılır bir menü 

olduğunu görebilirsiniz. Bu menüde: 

 

 Color mode: Çalışmanızın amacına uygun renk modunu belirleyebileceğiniz 

alandır. 
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 Raster effects: Yine çalışmanızın amacına uygun olarak belirleyebileceğiniz 

çözünürlük değerini girebileceğiniz alandır. Bu alana girdiğiniz değer, 

çalışmanızın kullanılacağı yere göre kullandığınız filtre ve efektlerin kalitesini 

koruyacaktır. 

 Preview mode:  Çalışma ekranınıza değişik ön izleme seçenekleri sunar ve 

“Default” olması yeterlidir. Değişik ön izlemelere ihtiyaç duyduğunuz takdirde 

“View” menüsünden faydalanabilirsiniz. 

 

İstediğiniz ayarları yapıp “OK” dediğiniz zaman çalışma alanınız açılacaktır. 

 

1.3. Programın Ara Yüzü 
 

 Menüler: Menüler aracılığı ile dosya ve dokümanların yönetilmesi sağlanır. 

 

 Status bar: Sayfanın bilgilerinin bulunduğu yerdir. 

 

 Artboard: Ön izlemede görülen sayfa alanı, sayfa alanı çizgileri dışında olan 

çizimler ön izlemede görünmeyecektir. 

 

 Floating palette: “Windows” menüsünden açtığınız bölümlerin kısayollarını 

koyabilirsiniz. 

 

 Control palette: “Tool Paneli”nden seçtiğiniz aracın özelliklerini burada 

bulabilir ve değiştirebilirsiniz. 
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Resim 1.5: Çalışma alanı 

 Toolbox (araç kutusu): Çizim yaparken kullanacağınız araçların bulunduğu 

bölümdür. Bir kez tıklayıp seçerek kullanabilirsiniz; bazılarında birden fazla 

araç vardır. Bunlara, basılı tutup erişebilirsiniz. Mouse imleci ile üzerinde 

beklenildiğinde ismi görünecektir. 
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Resim 1.6: Toolbox  

 

 Çizgi aracı: 

 
Çizgi, yay, spiral, dikdörtgen veya polar grid araçlarından birini seçtikten sonra fare 

işaretçisini, çizginin başlamasını istediğiniz yere getiriniz ve çizginin bitmesini istediğiniz 

yere sürükleyiniz. 
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Resim 1.7: Çizgi araçları 

 

 Çizgi aracının özellikleri 

 

o Uzunluk x ekseni: Çizginin genişliğini belirler. 

o Uzunluk y ekseni: Çizginin yüksekliğini belirler. 

o Tür: Nesnenin açık bir yol mu yoksa kapalı bir yol mu olmasını 

istediğinizi belirler. 

o Taban boyunca: Çizginin yönünü belirler. Yayı yatay (X) eksene 

paralel mi yoksa düşey (Y) eksene paralel mi çizmek istediğinize 

bağlı olarak x ekseni veya y eksenini seçiniz. 

o Eğim: Çizgi eğrisinin yönünü belirler. İçbükey eğri için negatif bir 

değer giriniz. Dışbükey eğri için pozitif bir değer giriniz. 0 

değerindeki eğri, düz bir çizgi çizer. 

o Yayı doldur: Çizgiyi geçerli dolgu rengiyle doldurur. 

 

Not: Seçenekleri ayarlarken hangi çizim aracını kullanıyorsanız dinamik ön izlemesini 

görmek için araçlar panelinde o aracı çift tıklayınız. 

 

 Alt seçim (subselection) aracı: 
 

Aşağıdakilerden birini yapınız: 

 Araçlar panelinde bir araca tıklayınız (Bir aracın sağ alt köşesinde küçük 

bir üçgen varsa gizli araçları görüntülemek için fare düğmesini basılı 

tutunuz, sonra seçmek istediğiniz araca tıklayınız.). 

 “Alt (Windows)” veya “Option (Mac OS)” tuşunu basılı tutunuz ve gizli 

araçlar arasında dolaşmak için bir araca tıklayınız. 

 Aracın klavye kısayoluna basınız. Klavye kısayolu, aracın araç ipucunda 

görüntülenir. Örneğin, taşıma aracını “V” tuşuna basarak seçebilirsiniz 

(Araç ipuçlarını gizlemek için: “Düzenle > Tercihler > Genel (Windows) 

veya Illustrator > Tercihler > Genel (Mac OS)”i seçiniz ve “Araç 

İpuçlarını Göster”deki işareti kaldırınız.). 
 

. 
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A. Araçlar paneli B. Etkin araç C. Gizli araçlara sahip paneli ayırma D. Gizli araç üçgeni E. Araç adı 

ve kısayolu 

Resim 1.8: Araçlar paneli 

 

 Vektörel program aşağıdaki seçim araçlarını sunar: 

 

 İçi dolu ok şeklindeki seçim aracı nesnelerin tamamını seçer. 

 

Resim 1.9: Seçim aracı (V) 

 

 İçi boş ok şeklindeki seçim aracı nesneler içindeki noktaları veya yol 

parçalarını seçer. 
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Resim 1.10: Doğrudan seçim aracı (A) 

 

 İçi boş ve yanında artı işareti olan seçim aracı gruplar içindeki nesneleri 

ve grupları seçer. 
 

 

Resim 1.11: Grup seçimi aracı 

 

1.4. Paneller 
 

Vektörel çizim programında birçok farklı bilgisayar programında olduğu gibi menüler 

aracılığıyla dosya ve dokümanların yönetilmesi sağlanmaktadır. Bu menüler temel menü 

uygulamalarının yanı sıra programa özgü paneller, bu panellerin alt ögeleri ve uygulama 

odaklı menüler içermektedir. 
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1.4.1. Temel Menüler 
 

 

Resim 1.12: Temel menüler paneli 

 

 File (dosya): File (dosya) başlığı altında yeni doküman açma, şablondan yeni 

doküman oluşturma, önceden üzerinde çalışılmış dosyalara ulaşma sekmeleri 

bulunmaktadır. Yeni dosya başlığı altında dosya kaydetme, farklı kaydetme, 

dışarıdan dokümanınıza eleman ekleme ve dokümanı yazdırma gibi seçeneklere 

ulaşabilirsiniz.  
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Resim 1.13: File menüsü 

 

 Edit (düzenleme): Edit (düzenleme) başlığı altında kesme, kopyalama, 

yapıştırma ve daha farklı ve gelişmiş ayarlar seçeneklerine ulaşabilirsiniz. 

 

 Object (nesne): Object (nesne) başlığı altında dokümanınız içindeki objeler 

üzerinde nesnelerin dönüşüm, konumlandırma, gruplandırma, gizleme ve 

kilitleme gibi özelliklerini değiştirmenize yarayan araçlar bulunur. 

 

 Type (yazım): Type (yazım) menüsü, dokümanınız içinde kullanacağınız 

metinlerin yazı büyüklüğü ve harflerin karakter değişiklikleri gibi özellikleri 

belirlemek için kullanılır. 

 
 Select (seç): Select (seç) bölümü, dokümanınız içindeki nesnelerin seçilmesi 

aşamasında size yardımcı olacak elemanları içerir. Seçili öge dışında kalan tüm 

elemanları seçmek için de “Inverse (tersini)” komutunu kullanabilirsiniz. 

 

 Efect (efekt): Efect (efekt) menüsü, üzerinde çalışmakta olduğunuz nesnelere, 

önceden hazırlanmış çeşitli özel efektleri uygulayabileceğiniz bir bölümdür. 
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 View (görünüm): View (görünüm) sekmesi, çalışma alanınızın nasıl 

görüneceğini ayarlayabileceğiniz bölümdür. Cetvel, kılavuz çizgileri ve 

ızgaraların ayarları ve daha birçok işlem bu sekme üzerinden takip edilebilir. 

 

 Cetvel: Çalışma alanında nesnelerin ölçülü ve kontrollü olarak yerleştirilmesi 

sağlanır. “View >Rules > Show Rules (cetvelleri göster)” seçeneğinden cetvel, 

çalışma alanında görünür duruma gelir. Cetvel üzerindeki ölçü birimini 

değiştirmek için cetvelin üzerine farenin sağ tuşu ile tıklayarak açılan menüden 

istediğiniz ölçü birimini seçebilirsiniz. 

 

 

Resim 1.14: Cetvel 

 Kılavuz çizgisi: Çalışma alanındaki nesneleri hizalamak için kılavuz 

çizgilerinden faydalanılır. Kılavuz çizgilerini ekrana getirmek için fare ile 

görünen sol ve üst cetvel görüntüsünden tıklayıp ekrana sürüklenip bırakılır. 

Kılavuz çizgisini silmek için fare ile silinecek kılavuz çizgisi seçilir ve “Delete” 

tuşu ile silinir. Kılavuz çizgilerinin ekranda görünürlüğünü kaldırmak için 

“View > Guides > Hide Guides” seçilir. 
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Resim 1.15: Kılavuz çizgisi 

 

 Izgara (grid): Çalışma alanı, hazır bölünmüş harita metot defterine benzer bir 

zemin sunar. Çalışma alanında nesnelerin ölçeklendirilmesi ve hizalama 

işlemlerini detaylı yapma imkânı sağlar. “View > Show Grid” seçilir. Izgarayı 

kaldırmak için “View > Hide Grid” seçilir. 

 

 

Resim 1.16: Izgara 
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Resim 1.17: Izgara 

 

Window (pencere): Window (pencere) başlığı altında çalışma alanı düzenleme 

seçenekleri bulunmaktadır. Programın ara yüzünde görünen daha fazla panele “Window” 

penceresinden ulaşabilirsiniz. Ekranda kapatmak istediğiniz panelin ismi üzerine tıklayarak 

seçili olmaktan çıkarabilirsiniz. Aşağıdaki resimde yanında işaret bulunan paneller ekranda 

açık olarak görülmektedir. 

 

Resim 1.18: Window (pencere) menüsü 

 

Help (yardım): Help (yardım) menüsü ise program ve kullanıma yönelik sorularınıza 

cevap bulabileceğiniz geniş bir veritabanı içermektedir. 
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1.4.2. Kontrol Paneli 
 

Temel menülerin altındaki bölüm kontrol panelidir. Doküman içinde seçilen nesne 

veya araca göre değişmektedir. Örneğin, çizdiğiniz bir karenin dolgu rengini veya çizgi 

rengini verme, çizgi kalınlığını değiştirme, çizilen birden fazla nesnenin hizalanması, opak 

ayarının (opacity) yapılması gibi birçok değişiklikler bu kısımda yapılır. 

 

 

Resim 1.19: Kontrol (control) paneli 

 

1.5. Kısayollar 
 

Klavye kısayolları, vektörel çizim program uygulamalarında daha verimli olmanızı 

sağlar. Burada menülerin içinde ve araçlar panelinde listelenen varsayılan kısayolları 

kullanabilir, ihtiyaçlarınıza göre kısayol ekleyebilir veya var olan kısayolları 

özelleştirebilirsiniz.  
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Resim 1.20: Direct selection tool 

 

 

Resim 1.21: Edit menüsü kısayollar 

1.6. Görünümleri Değiştirmek 
 

Varsayılan değer olarak vektörel çizim programınız resmin tamamının ön izlemesi 

renkli olarak yapılacak bir görünüm kullanır. Ancak resmi sadece ana hatları (veya yolları) 

görünür olacak şekilde görüntülemeyi seçebilirsiniz. Resmin boyama nitelikleri olmaksızın 
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görüntülenmesi, karmaşık resimlerle çalışırken ekranın yeniden çizilme süresini kısaltır. Ana 

hat modunda bağlantılı dosyalar, varsayılan değer olarak içlerinde bir “X” bulunan, ana hat 

kutuları olarak görüntülenir. 

 

Bağlantılı dosyaların içeriğini görüntülemek için: “File > Document Setup”ı seçiniz, 

iletişim kutusunun üst kısmında “Show İmages in Outline Mode (Görüntüleri Ana Hat 

Modunda Göster)” ayarını işaretleyiniz. 

 

            

Resim 1.22: Document setup (ana hat modunun penceresi) 

 

 Resmin tamamını ana hatlar olarak görüntülemek için:  “View (Görünüm) > 

Outline (Ana Hat)” seçilir. Tekrar renkli resim ön izlemesine geri dönmek için: 

“View (Görünüm)  > Preview (Ön izleme)” seçilir. Kısayolu “Ctrl+Y”dir. 

Tekrar çizimi renkli olarak görüntülemek için “Ctrl+Y” tuşuna tekrar tıklanır. 

 

  

Resim 1.23: Resmi ana hat modunda görüntüleme (outline) 
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 Bir katmandaki bütün resimleri ana hatlar olarak görüntülemek için katmanlar 

panelinde o katmanın göz simgesine “Ctrl (Windows)” veya “Command (Mac 

OS)” tuşunu basılı tutarak tıklayınız. Renkli resim ön izlemesine geri dönmek 

için yine “Ctrl (Windows)” veya “Command (Mac OS)” tuşunu basılı tutup 

tıklayınız. Ana hat görünümü etkinleştirildiğinde göz simgesinin gözbebeği 

boştur. Ön izleme etkinleştirildiğinde doludur. 

 

      

 

 

Resim 1.24: Appearence penceresi (görünüm paneli) 

1.7. Görüntüyü Yakınlaştırma ve Uzaklaştırma 
 

Resminizi yakınlaştırmanın veya uzaklaştırmanın birkaç yolu vardır. 

 

 Yakınlaştırma aracını seçiniz.  Fare işaretçisi, ortasında artı işareti bulunan 

bir büyütece dönüşür. Büyütmek istediğiniz alanın ortasını tıklayınız veya 

küçültmek istediğiniz alanın ortasını “Alt (Windows)” veya “Option (Mac OS)” 

tuşunu basılı tutarak tıklayınız. Her tıklama, görünümü bir önceki hazır ayar 

yüzdesine göre büyütür veya küçültür. 
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Resim 1.25: Yakınlaştırma örneği (zoom) 

 

 Yakınlaştırma aracını  seçiniz ve büyütmek istediğiniz alanın çevresine 

sürükleyerek seçim çerçevesi adı verilen kesikli bir dikdörtgen çiziniz. Seçim 

alanını resmin içinde hareket ettirmek için “Boşluk” (Space) tuşuna basılı 

tutunuz ve sürüklemeye devam ederek seçim çerçevesini yeni bir konuma 

taşıyınız. 

 

 “View (görünüm) > Zoom In (Yakınlaştır)” veya “Zoom Out (Uzaklaştır)” 

seçiniz. Her tıklama, görünümü bir sonraki hazır ayar yüzdesine göre büyütür 

veya küçültür. 
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Resim 1.26: Yakınlaştırma menüsü örneği  

 

 Yakınlaştırma düzeyini, ana pencerenin sol alt köşesinden veya gezgin 

panelinden ayarlayabilirsiniz. 
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Resim 1.27: Yakınlaştırma panel menüsü  

 

 Dosyayı % 100 boyutta görüntülemek için: “View (Görünüm) > Actual Size 

(Gerçek Boyut)” seçiniz veya yakınlaştırma aracını çift tıklayınız. 

 Görünümü, belge penceresine sığacak şekilde değiştirmek için: “View 

(Görünüm) > Fit All In Window (Pencereye Sığdır)” seçiniz veya “Hand Tool 

(El Aracı)” aracına çift tıklayınız. 
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Resim 1.28: Görünüm menüsü sığdır seçeneği (fit all in window)  

 

1.8. Temel Şekiller Oluşturma 

 
1.8.1. Dikdörtgenler, Elipsler, Yıldızlar ve Çokgen Oluşturma 

 

 Dikdörtgenler ve kareler çizme 

 

 “Dikdörtgen aracını (Rectangle Tool)” veya “Yuvarlak Köşeli 

Dikdörtgen (Rounded Rectangle Tool)” aracını seçiniz. 

 Aşağıdakilerden birini yapınız: 

 

o Bir dikdörtgen çizmek için dikdörtgen istediğiniz boyuta gelinceye 

kadar diyagonal olarak sürükleyiniz.  

o Bir kare çizmek için kare istediğiniz boyuta gelinceye kadar 

“Shift” tuşunu basılı tutarak diyagonal olarak sürükleyiniz. 
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Resim 1.29: Şekil aracı 

 

 Elips çizme 

 

 Elips aracını seçiniz. 

 Aşağıdakilerden birini yapınız. 

 

o Elips istediğiniz boyuta gelinceye kadar diyagonal olarak 

sürükleyiniz. 

o Çizmek istediğiniz elipsin sınırlayıcı kutusunun sol üst köşesinin, 

çalışma sayfanızda olmasını istediğiniz yere tıklayınız. Elipsin 

genişliğini ve yüksekliğini belirleyip “Tamam” düğmesine 

tıklayınız. 

 

Not: Daire çizmek için sürüklerken “Shift” tuşunu basılı tutabilir veya boyutları 

belirliyorsanız genişlik değerini girdikten sonra aynı değeri “Yükseklik” kutusuna 

kopyalamak için “Yükseklik” kelimesine tıklayabilirsiniz.  

 

 Çokgen çizme 

 

 Çokgen aracını seçiniz. 

 Aşağıdakilerden birini yapınız. 

 

o Çokgen istediğiniz boyuta gelinceye kadar sürükleyiniz. Çokgeni 

döndürmek için işaretçiyi bir yay çizecek şekilde sürükleyiniz. 

Çokgene kenar eklemek veya çokgenden kenar kaldırmak için 

“Yukarı Ok” veya “Aşağı Ok” tuşlarına basınız. 

o Çokgenin merkezinin olmasını istediğiniz yere tıklayınız. Bir 

yarıçap ve poligonun kenar sayısını belirleyip “Tamam” 
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düğmesine tıklayınız. Üçgenler de çokgendir. Başka herhangi bir 

poligon gibi üçgen de çizebilirsiniz. 

 

 

Resim 1.30: Polygon penceresi 

 

 Yıldız çizme 

 

 Yıldız aracını seçiniz. 

 Aşağıdakilerden birini yapınız. 

 

o Yıldız istediğiniz boyuta gelinceye kadar sürükleyiniz. Yıldızı 

döndürmek için işaretçiyi bir yay çizecek şekilde sürükleyiniz. 

Yıldıza köşe eklemek veya yıldızdan köşe kaldırmak için “Yukarı 

Ok” veya “Aşağı Ok” tuşlarına basınız. 
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Resim 1.31: Yıldız çizimi 

 

o Yıldızın merkezinin olmasını istediğiniz yere tıklayınız. Yarıçap 1 

(Radius1) için yıldızın ortasından yıldızın en içteki iç köşelerine 

kadar olan mesafeyi belirleyiniz. Yarıçap 2 (Radius2) için yıldızın 

ortasından yıldızın en dıştaki dış köşelerine kadar olan mesafeyi 

belirleyiniz. Köşeler (points) alanında, yıldızın kaç köşeli olmasını 

istediğinizi belirtiniz. Sonra “Tamam” düğmesine tıklayınız. 

 

 

Resim 1.32: Yıldız (star) çizimi penceresi 

 

1.8.2. Şekilleri Boyutlandırma 
 

Efektleri kullanmak, temel geometrileri üzerinde kalıcı değişiklikler yapmaksızın 

nesneleri yeniden şekillendirmenin kolay bir yoludur. Efektler canlıdır, yani istediğiniz 

zaman efekt üzerinde değişiklik yapabilir veya efekti kaldırabilirsiniz. 
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Nesneleri yeniden şekillendirmek için aşağıdaki efektleri kullanabilirsiniz: 

 

Resim 1.33: Boyutlandırma menüsü 

 

 Şekle dönüştür (3D): Vektör, nesnelerinin şeklini dikdörtgene, yuvarlak köşeli 

dikdörtgene veya elipse dönüştürür. Mutlak veya göreli boyutlar kullanarak 

şeklin boyutlarını ayarlar.  

 

 Deforme et ve dönüştür (convert to shape): Vektör nesnelerini kolayca 

yeniden şekillendirmenizi sağlar. 

 

 Serbest deformasyon (crop masks): Dört köşe noktasından herhangi birini 

sürükleyerek bir vektör nesnesinin şeklini değiştirmenizi sağlar. 

 

 Büz ve şişir (disort&transform): Bir vektör nesnesinin bağlantı noktalarını 

dışa doğru çeker, aynı zamanda çizgi parçalarını içe (büz) veya dışa (şişir) eğer. 

Her iki seçenek de bağlantı noktalarını nesnenin orta noktasına göreli olarak 

çeker. 

 

 Kabalaştır (path): Bir vektör nesnesinin yol parçalarını, çeşitli boylarda 

çıkıntılardan ve girintilerden oluşan tırtıklı bir hatta dönüştürür. Mutlak veya 

göreli boyutu kullanarak yol parçalarının maksimum uzunluğunu belirleyiniz. 

Tırtıklı kenarların inç başına düşen sıklığını (ayrıntı) ayarlayınız ve yumuşak 

kıvrımlı köşeler (düzgün) veya sivri kenarlar (köşe) arasında seçim yapınız. 

 

 Dönüştür (pathfinder): Bir nesneyi yeniden boyutlandırıp taşıyarak, 

döndürerek, yansıtarak ve kopyalayarak yeniden şekillendirir. 
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 İnce ayar (rasterize): Yol parçalarını içe ve dışa doğru rastgele eğer ve 

deforme eder. Mutlak veya göreli miktarı kullanarak dikey ve yatay 

deformasyon miktarını ayarlayınız. Bağlantı noktalarının değiştirilip 

değiştirilmeyeceğini, kontrol noktalarının yol üzerindeki bağlantı noktalarında 

içe doğru kayıp kaymayacağını (iç kontrol noktaları) ve kontrol noktalarının yol 

üzerindeki bağlantı noktalarında dışa doğru kayıp kaymayacağını (dış kontrol 

noktaları) belirleyiniz. 

 

 Bük (stylize): Bir nesneyi, ortada kenarlardan daha fazla olmak üzere döndürür. 

Pozitif bir değer girdiğinizde saat yönünde, negatif değer girdiğinizde saat 

yönünün tersine bükülür. 

 

 Zikzak (svg filters): Bir nesnenin yol parçalarını, bir örnek boyutlandırılmış bir 

dizi çıkıntıdan ve girintiden oluşan tırtıklı veya dalgalı bir hatta dönüştürür. 

Mutlak veya göreli boyutu kullanarak çıkıntılar ve girintiler arasındaki 

uzunluğu belirleyiniz. Yol parçası başına düşen tırtık sayısını belirleyiniz ve 

dalgalı kenarlar (düzgün) veya tırtıklı kenarlar (köşe) arasında seçim yapınız. 

 

Aynı sonuçları filtrelerle de elde edebilirsiniz (Filtre menüsünün üst kısmındaki filtre 

> deforme et). Ancak bir filtreyi uyguladıktan sonra değiştiremezsiniz. Oysa efekti 

istediğiniz zaman değiştirebilir veya kaldırabilirsiniz. 

 

 Çarpıt (warp): Yollar, metinler, kafesler, karışımlar ve bitmap görüntüler dâhil 

olmak üzere nesneleri deforme eder. Hazır çarpıtma şekillerinden birini seçiniz. 

Sonra, eğme seçeneğinin hangi ekseni etkileyeceğini seçiniz ve uygulanacak 

eğme ve deformasyon miktarını belirleyiniz. 

 

1.9. Çizim Araçları  
 

1.9.1. Pen Aracını Kullanma 
 

 Pen tool (dolmakalem): Kısayolu “P”dir. Bu aracın kullanımı ilk etapta 

karmaşık görünebilir. Kullandıkça basit ve faydalı bir araç olduğu görülür.  
 

Çizim yaparken yol olarak adlandırılan bir çizgi oluşturursunuz. Her parçanın başı ve 

sonu, tıpkı bir kabloyu sabit tutan pimler gibi işlev gören bağlantı noktaları tarafından 

işaretlenir. Bir yol kapalı (örneğin bir daire) veya açık, yani bariz uç noktalara sahip (örneğin 

dalgalı bir çizgi) olabilir. Yolun bağlantı noktalarını, bağlantı noktalarında görünen yön 

çizgilerinin sonundaki yön noktalarını ya da yol parçasının kendisini sürükleyerek yolun 

şeklini değiştirebilirsiniz. 
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Resim 1.34: Dolmakalem (pen) aracı kullanımı 

 

“Pen Tool” seçildikten sonra istenilen bir noktaya tıklanır. Oluşan nokta ilk “Anchor 

Point(kırmızı daire)”tir. İkinci bir noktaya (yeşil daire) tıklandığında handlelerin (mavi 

daireler) oluştuğu görülebilir. Handleler yardımıyla 3. noktanın yönü (siyah daire), 1. ve 2. 

nokta arasındaki kavisin şekli belirlenebilir. 2. nokta tıklandıktan sonra yeni bir noktaya 

tıklanırsa 2. noktadan önceki oluşan kavise uygun yeni bir kavis meydana gelecektir.  

 

Eğer kavisin farklı bir şekilde olmasını istiyorsanız maus ile “2. Anchor Points” 

üzerine tıklamalısınız. Bu durumda handlelerden biri kaybolacak; 1. ve 2. noktalar arasındaki 

“Path”in kavisi 2. ve 3. nokta arasındaki kavisi çizimden önce ve sonra etkilemeyecektir. 

 

.  

Resim 1.35: Dolmakalem aracı kullanımı 
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Eğer “Pen Tool” ile düz bir çizgi oluşturmak istiyorsanız “Shift” tuşuyla yeni noktaya 

tıklamak yeterlidir. 

 

 

Resim 1.36: Dolmakalem aracı kullanımı 

 

 Add anchor point: “Pen Tool” aracının altındaki gizli araçlardandır. “Pen 

Tool” üzerine gelip bir süre mausa basılı tutarak bu araca ulaşılabilir. “Pen 

Tool” ile yapılan bir çizime ya da herhangi bir “Path”e yeni “Anchor Point” 

eklemek için kullanılır. “Path” çizgisi üzerinde istenilen yere tıklanması 

yeterlidir. 

 

 

Resim 1.37: Dolmakalem aracı seçenekleri 
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 Delete anchor point: “Pen Tool” aracının altındaki gizli araçlardandır. “Pen 

Tool” ile yapılan bir çizimden ya da herhangi bir “Path”ten istenilen bir 

“Anchor Point”in silinmesi için kullanılır. “Path” çizgisi üzerinde istenilen 

“Point”e tıklanması yeterlidir. 

 

 

Resim 1.38: Dolmakalem aracı seçenekleri 

 

 Convert anchor point: Kısayolu “Shift + C” olan bu araç, “Pen Tool” 

aracının altındaki gizli araçlardandır. “Pen Tool” ile yapılan bir çizimden ya da 

herhangi bir “Path”ten istenilen bir “Anchor Point”in handlelerinin silinmesi ve 

kavisin kaldırılarak düz bir çizgi oluşturmak amacıyla kullanılır. “Path” çizgisi 

üzerinde istenilen “Point”e tıklanması yeterlidir. 

 

 

Resim 1.39: Dolmakalem aracı seçenekleri 
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1.9.2. Line Segment Tool 
 

Düz ve köşeli çizimlerde kullanabilirsiniz. “Shift” tuşuna basılı tutarak düz çizgi 

çizebilirsiniz. 

 

 

 

Resim 1.40: Çizgi aracı (line) kullanımı 

 

1.9.3. Pencil Tool 
 

“Pencil Tool”u seçip istediğiniz gibi çizim yapabilirsiniz. “Pencil Tool” ile çizimde 

başladığınız noktaya döndüğünüzde çiziminiz kapalı hâle gelir ve dolgu rengi verebilirsiniz.  

 

 

Resim 1.41: Pencil tool kullanımı 

 

“Pencil” üzerine iki kez tıklayarak “Pencil Tool Preferences” paneli açılır. 

 

 Fidelity: Çizimi daha yumuşak yapar yani çizdiğiniz çizgi ayarı ne kadar düşük 

olursa o kadar noktalardan oluşur; ne kadar yüksek olursa o kadar az noktasız 

olur. 

 

 Smoothness: Ne kadar az olursa o kadar düzgün bir çizim olur. 
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Resim 1.42: Pencil tool preferences tool (kalem aracı seçenekleri) 
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UYGULAMA FAALİYETİ 
 

Aşağıdaki işlemleri tamamladığınızda vektörel programda geometrik form çizimlerini 

kurallarına uygun olarak çizmiş olacaksınız. 

 

Kullanılacak araç gereçler: 

 
 Bilgisayar 

 Tarayıcı 

 Yazıcı 

 

İşlem Basamakları Öneriler 

 Vektörel programda geometrik form çizimleri yapmak için 

bilgisayarınızda programınızı açınız. 

 Atölye önlüğünüzü 

giymeyi 

unutmayınız. 

 Ekranınızın sol üst köşesinde bulunan file sekmesinin alt 

seçeneklerinden biri olan “New”i tıklayarak yeni bir 

doküman açınız. 

 Çalışma 

dokümanınıza isim 

vermeyi 

unutmayınız. 

 “View” sekmesinin alt seçeneklerinden cetvellerinizi açınız.  

 Çiziminizin düzgün olması için cetvelinizin kılavuz 

çizgilerini yerleştiriniz. 
 

 Program çalışma alanında ekranınızın sol tarafındaki araçlar 

kutusundan  kalem aracını seçiniz. 
 

 Görünüm menüsünden çizgi ve dolgu ayarlarını yapınız. 

 

 
 

 

 Kılavuz çizgilerini de kullanarak çalışma sayfasında 

başlangıç noktanızı yerleştiriniz. 
 

 İkinci noktayı aynı kılavuz çizgi üzerinde kavis oluşturarak 

yerleştiriniz. 

 Kavisi oluştururken 

“Shift” tuşuna 

basmayı 

unutmayınız. 

UYGULAMA FAALİYETİ 
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 Çiziminizi ilk belirlediğiniz noktaya tıklayarak bitiriniz. 

 

 Kapalı çizim 

oluşturmak için 

başlangıç noktasına 

tıklamayı 

unutmayınız. 

 “Temel Şekil Araçları”nı kullanarak çizim yapmak için 

araçlar kutusundan “Temel Çizim Araçları”nı seçiniz. 

   

 

 “Dikdörtgen”  aracını seçiniz.  Çalışma alanınızın 

üzerinde dikdörtgen istediğiniz boyuta gelinceye kadar 

diyagonal olarak sürükleyerek çekiniz. 
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 Bir kare çizmek için kare istediğiniz boyuta gelinceye kadar 

“Shift” tuşunu basılı tutarak diyagonal olarak sürükleyiniz. 

 

 

 Değerler kullanarak bir kare veya dikdörtgen oluşturmak 

için sol üst köşesinin olmasını istediğiniz yere tıklayınız. 

Bir genişlik ve yükseklik değeri belirleyiniz ve “Tamam” 

düğmesine tıklayınız. 

 Yuvarlak köşeli 

dikdörtgen için bir 

köşe yarıçapı 

belirlemeyi 

unutmayınız. 
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 Yuvarlak köşeli bir dikdörtgen çizmek için köşe yarıçapını 

değiştirmelisiniz.  

 

 

 Elips istediğiniz boyuta gelinceye kadar diyagonal olarak 

sürükleyiniz. 

 

 Elipsin sınırlayıcı 

kutusunun sol üst 

köşesinin olmasını 

istediğiniz yere 

tıklayarak elipsinizin 

genişliğini ve 

yüksekliğini 

belirleyebilirsiniz, 

unutmayınız. 

 Daire çizmek için 

sürüklerken “Shift” 

tuşunu basılı 

tutmalısınız, 

unutmayınız. 

 

 Çokgen istediğiniz boyuta gelinceye kadar sürükleyiniz.  
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 Yıldız istediğiniz boyuta gelinceye kadar sürükleyiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

Aşağıdaki yarım daire çizimlerini vektörel çizim programıdaki uygun çizim 

araçlarından faydalanarak çiziniz ve çalışmanızı aşağıdaki değerlendirme ölçütlerine göre 

değerlendiriniz. 

 

 

 

 

KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Bilgilerinizi gözden geçirdiniz mi?   

2. Vektörel çizim programını açtınız mı?   

3. Çalışma alanınızı açtınız mı?   

4. Cetvellerinizi açtınız mı?   

5. Kılavuz çizgilerinizi yerleştirdiniz mi?   

6. Görünüm ayarlarınızı yaptınız mı?   

7. Dolmakalem aracını seçtiniz mi?   

8. Kılavuz çizgilerine göre çiziminizi yaptınız mı?   

9. Zamanı verimli kullanmaya dikkat ettiniz mi?   

10. Çalışmanızdan memnun kaldınız mı?   

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 

 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–2 
 

 

 

 

Bu faaliyette verilecek bilgiler doğrultusunda uygun ortam sağlandığında vektörel 

programda geometrik formları tasarı ilkelerine göre düzenleyebileceksiniz.  

 

 

 

 

 

 Vektörel çizim ile ilgili basılı ve görsel kaynakları inceleyiniz. 

 

2. DÖNÜŞTÜRME VE BOYUTLANDIRMA 

ARAÇLARI İLE ÇALIŞMA 
 

2.1. Şekilleri Taşıma ve Kopyalama 
 

Nesneleri, belirli araçlarla sürükleyerek klavyedeki ok tuşlarını kullanarak veya bir 

panelde ya da iletişim kutusunda kesin değerleri girerek taşıyabilirsiniz. Nesnelerin birbirine 

göre konumlarını ayarlamak için “Hizalama (Align)” panelini de kullanabilirsiniz.  

 

 

Resim 2.1: Hizalama (aling) paneli 

 

Bir veya birden çok nesnenin hareketini sınırlamak için “Shift” tuşuna basılı tutarak 

nesnelerin X ve Y eksenlerinin o anki yönlendirme durumuna göre tam yatay, düşey veya 

diyagonal yönde hareket etmesini de sağlayabilirsiniz. “Shift” tuşunu, nesneleri 45 derecenin 

katlarında döndürmek için de kullanabilirsiniz. 

 

ÖĞRENME FAALİYETİ–2 

AMAÇ 

ARAŞTIRMA 
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Resim 2.2: Şekilleri taşıma 

 

 Bir nesneyi yapıştırarak taşıma veya çoğaltma 

 

Bir veya birden çok nesne seçiniz. 

Seçimi taşımak için: 

“Edit > Cut” veya çoğaltmak için “Edit > Copy”yi seçiniz. 

Nesneyi başka bir dosyaya yapıştırmak için o dosyayı açınız.  

Aşağıdaki komutlardan birini seçiniz: 

 

“Edit > Past”, nesneyi etkin durumdaki pencerenin merkezine yapıştırır. 

“Edit > Past in Front”, nesneyi seçili nesnenin hemen önüne yapıştırır. 

“Edit > Past in Back”,  nesneyi seçili nesnenin hemen arkasına yapıştırır. 

 

 

Resim 2.3: Edit menüsü yapıştırma seçenekleri 

 

2.2. Şekilleri Boyutlandırma 
 

Nesneleri seçme aracını kullanarak boyutlandırırsınız. Seçilmiş nesnenin köşelerinde 

beliren noktalarından istenilen yöne çekilerek nesnenin boyutu değiştirilir. “Shift” tuşuna 

basılı tutularak yapılan ölçeklendirmede nesnenin en ve boyunda eşit oranda büyüme veya 
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küçülme sağlanır. Nesnenin ölçülerini “Control” panelindeki “Transform” panelinden 

(Window >Transform) görebilirsiniz. 

 

Resim 2.4: Şekli boyutlandırma 

 

“Rectangle Tool” çizim aracını seçiniz ve çalışma sayfasına tıklayınız. Ekrana çıkan 

“Rectangle” kutusunda çizimi yapacağınız dikdörtgenin ölçülerini belirleyebilirsiniz. 

 

 

Resim 2.5: Şekli boyutlandırma 

 

Çizilmiş dikdörtgenin ölçüsünü değiştirmek için başka bir yöntem; dikdörtgen seçili 

iken araç kutusundan “Rectangle Tool” seçilir ve çizim üzerine fare ile tıklanır. Ekranda 

beliren “Rectangle” kutusundan istenilen ölçüler girilir. 



 

 45 

 

Resim 2.6: Şekli boyutlandırma 

 

Nesne seçili iken araç kutundan “Scale Tool” üzerine iki kere tıklanır. Ekrana çıkan 

“Scale” kutusunda yüzdelik büyüme veya küçültme değeri verilir. 

 

 

Resim 2.7: Şekli boyutlandırma 

 

2.3. Şekilleri Eğme ve Bükme 
 

Bir nesnenin eğilmesi, nesneyi yatay veya düşey eksende ya da belirlenen eksene 

göreli, belirtilen bir açıyla eğer veya eğriltir. Nesneler, seçtiğiniz eğme yöntemine göre 

değişen ve eğme yöntemlerinin çoğunda değiştirilebilen bir referans noktasına göreli olarak 

eğilir. Eğerken nesnenin bir boyutunu kilitleyebilir ve bir nesneyi veya birden çok nesneyi 

bir arada eğebilirsiniz. Aşağıdaki resimde ortaya göreli yamultma (solda) ve kullanıcı 

tarafından tanımlanan bir referans noktasına göreli yamultma (sağda) inceleyebilirsiniz. 
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Resim 2.8: Şekilleri eğme örneği 

 

 Nesneleri yamultma aracıyla eğme 

 

 Bir veya birden çok nesne seçiniz. 

 Araç kutusundan eğme aracını (Shear Tool)  seçiniz. 

 Aşağıdakilerden birini yapınız: 

 

o Nesnenin orta noktasına göreli olarak eğmek için belge penceresi 

içinde istediğiniz yere sürükleyiniz. 

o Farklı bir referans noktasına göreli olarak eğmek için belge 

penceresinde istediğiniz noktayı tıklayınız. Fare işaretçisini 

referans noktasından uzaklaştırınız, sonra nesne istediğiniz eğime 

gelene kadar sürükleyiniz. 

o Nesnenin düşey eksenine göreli olarak eğmek için belge penceresi 

içinde yukarı veya aşağı doğru istediğiniz yere sürükleyiniz. 

Nesneyi orijinal genişliğiyle sınırlamak için “Shift” tuşuna basılı 

tutunuz. 

o Nesnenin yatay eksenine göreli olarak eğmek için belge penceresi 

içinde sola veya sağa doğru istediğiniz yere sürükleyiniz. Nesneyi 

orijinal yüksekliğiyle sınırlamak için “Shift” tuşuna basılı tutunuz. 

 

 Nesneleri serbest dönüştürme aracıyla eğme  

 

 Bir veya birden çok nesne seçiniz. 

 Araç kutusundan “Free Transform Tool (Serbest Dönüştürme)  

aracı”nı seçiniz. 

 Aşağıdakilerden birini yapınız: 

 

o Nesnenin düşey eksenine göreli olarak eğmek için sınırlayıcı 

kutunun sol orta veya sağ orta tutamacını sürüklemeye başlayınız. 

Sonra aşağı veya yukarı doğru sürüklemeye devam ederken 

“Ctrl+Alt (Windows)” veya “Option+Command (Mac OS)” 

tuşlarını basılı tutunuz. Nesneyi orijinal genişliğiyle sınırlamak için 

“Shift” tuşunu da basılı tutabilirsiniz. 
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o Nesnenin yatay eksenine göreli olarak eğmek için sınırlayıcı 

kutunun üst orta veya alt orta tutamacını sürüklemeye başlayınız. 

Sonra sola veya sağa doğru sürüklemeye devam ederken “Ctrl+Alt 

(Windows)” veya “Option+Command (Mac OS)” tuşlarını basılı 

tutunuz. Nesneyi orijinal yüksekliğiyle sınırlamak için “Shift” 

tuşunu da basılı tutabilirsiniz. 

 

Resim 2.9: Perspektifli olarak deforme etme 

 

2.4. Şekilleri Döndürme 

 
Nesne seçili iken etrafında görünen seçim kutusunun köşesine fare imleci ile 

yakınlaştığında imleç eğik bir çizgi şeklini alır. Farenin sol tuşuna basarak hareket 

ettirildiğinde nesne merkezi ekseninde döner. Aynı işlemi “Shift” tuşuna basılı iken 

yaptığınızda nesneyi 45
o
 ve katlarında döndürme işlemi gerçekleşir. 

 

 

Resim 2.10: Şekilleri döndürme örneği 
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 Bir nesneyi “Rotate Tool (Serbest Dönüştürme)” ile döndürme  

 

 Bir veya birden çok nesne seçiniz. 

 Araç kutusundan “Rotate Tool (Serbest Dönüştürme)   aracı”nı 

seçiniz. 

 Fare işaretçisini, artı işareti şeklini alacak şekilde sınırlayıcı kutunun 

dışında bir yere götürerek ve sürükleyiniz. 

 

 Açı vererek döndürme: 

 

Nesne seçili iken araç kutusundan “Rotate Tool”a çift tıklanır. Çıkan “Rotate” 

penceresinde “Angle (Açı)” kısmına döndürülmek istenen açı değeri girilir. 

 

 

Resim 2.11: Şekli döndürme 

 

2.5. Şekilleri Yansıtma ve Yamultma 

 
Nesneler üzerinde yansıtma ve yamultma işlemi yapmak için araç kutusundan “Reflect 

(Yansıtma) ve Shear (Yamultma)” araçlarına nesne seçili iken çift tıklanarak sayfada beliren 

pencereye değerler verilir. 
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Resim 2.12: Yansıtma (reflect) aracı örneği 

 

 

Resim 2.13: Yamultma (shear) aracı örneği 

 

2.6. Bileşik Şekiller ve Yol Bulucular Kullanarak Şekil Oluşturma 
 

“Compound Shapes (Bileşik Şekiller)”, bir tek şekil gibi görünen ancak birden fazla 

şekilden oluşan nesnelerdir. Birleştirildikten sonra her ne kadar tek bir nesne gibi hareket 

ettirilseler de doğrudan seçim aracıyla seçtiğinizde hâlâ yolları ve bağ noktalarıyla 

oynayabildiğinizi görebilirsiniz. Bu değişimleri yapmak için “Window (Pencere)” menüsü 

altında “Pathfinder (Yol Bulucu)” panelini açıyorsunuz. 
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Resim 2.14: Pathfinder paneli 

 

 Öndekini çıkartma 

 

 İç içe iki daire çiziniz. 

 İki nesneyi de seçiniz. 

 Yol bulucu penceresinden “Minus Front (Öndekini Çıkart)” tuşuna 

tıklayınız. 

 

 

Resim 2.15: Pathfinder paneli şekiller modu minus front 

 

Bu işlem sonucu birleşik bir şekil oluşturursunuz. Seçim aracıyla seçtiğinizde tek bir 

nesne olarak hareket edecektir. Doğrudan seçim aracı ile seçtiğiniz noktaları taşıyabilirsiniz. 
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Resim 2.16: Bileşik şekillerde doğrudan seçim aracının kullanımı 

 

Oluşturduğunuz bileşik şekilleri ayrı ayrı hareket ettirmek veya yerini değiştirmek için 

bileşik şekil üzerindeyken mausunuza sağ tıkladığınızda açılan menüden “Release 

Compound Path” seçerek iki daire olmasını sağlayabilirsiniz. 

 

 

 

Resim 2.17: Bileşik şekilleri ayırma 
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Resim 2.18: Bileşik şekilleri ayırma ve yer değiştirme 

 

Ayırdığınız dairenin yerini değiştirip seçim aracı ile iki daireyi de seçerek tekrar 

“Minus Front (Öndekini Çıkart)” tuşuna tıklayınız. 

 

Birbirinden farklı ve farklı renkte iki nesne çizerek şekil modlarını sırasıyla 

uygulayınız. 

 

 Sağ üst köşedeki 1 numaralı şekillere “Unite (Birleştir)” komutu 

uyguladığınızda alttaki 2 numaralı şekli elde edersiniz. 

 Sağ üst köşedeki 1 numaralı şekillere “Minüs Front (Öndekini Çıkar)” 

komutu uyguladığınızda alttaki 3 numaralı şekli elde edersiniz. 

 Sağ üst köşedeki 1 numaralı şekillere “İntersect (Kesiştir)” komutu 

uyguladığınızda alttaki 4 numaralı şekli elde edersiniz. 

 Sağ üst köşedeki 1 numaralı şekillere “Exlude (Dışla)” komutu uyguladığınızda 

alttaki 5 numaralı şekli elde edersiniz. 

 

Resim 2.19: Şekil modları 
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Birbirinden farklı ve farklı renkte iki nesne çizerek yol bulucu komutlarının nasıl 

etkileri olduğunu sırasıyla uygulayarak inceleyiniz. 

 

 

Resim 2.20: Yol bulucu komutları 

 

2.7. Şekilleri Renklendirme 
 

Bir nesnenin tamamına bir renk, desen veya degrade uygulayabilir veya “Canlı 

Boyama” grupları kullanarak nesne içindeki farklı yüzeylere farklı renkler 

uygulayabilirsiniz. 

 

 Nesneyi seçiniz. 

 “Araçlar” panelindeki veya “Renk” panelindeki “Dolgu” kutusunu tıklayınız 

(Bu, bir kontur değil dolgu uygulamak istediğinizi belirtir.). 
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Resim 2.21: Dolgu kutusu 

 

 Aşağıdakilerden birini yaparak bir dolgu rengi seçiniz: 

 

 Kontrol panelinde, renk panelinde, renk örnekleri panelinde, degrade 

panelinde veya bir renk örneği kitaplığında bir rengi tıklayınız. 

 “Renk Seçici”den renk seçmek için “Dolgu” kutusunu çift tıklayınız. 

 Damlalık aracını seçiniz ve mevcut dolgu ve kontur dâhil olmak üzere 

mevcut özellikleri bir nesneye uygulamak için “Alt (Windows)” veya 

“Option (Mac OS)” tuşunu basılı tutup o nesneyi tıklayınız. 

 Nesnenin mevcut dolgusunu kaldırmak için “Yok” düğmesini tıklayınız. 

Dolgu kutusundan, renk panelinden, degrade panelinden veya renk 

örnekleri panelinden bir rengi seçili olmayan bir nesneye sürükleyerek o 

nesneye kolayca renk uygulayabilirsiniz. Sürükleme işlevi, canlı boyama 

gruplarında işe yaramaz. 

 

 Kontur rengi, genişliği veya hizalamasını uygulama 

 

 Nesneyi seçiniz (Canlı boyama grubundaki bir kenarı seçmek için “Canlı 

Boyama Seçimi” aracını kullanınız.). 

 Araçlar panelindeki, renk panelindeki veya kontrol panelindeki “Kontur 

Kutusu”nu tıklayınız (Bu, bir dolgu değil kontur uygulamak istediğinizi 

belirtir.). 

 

 

Resim 2.22: Kontur kutusu 

 

 Renk seçiciyi (Color Picker) görüntüleme 

 

Bir renk grubundaki veya resimdeki renklerin kesin şekilde tanımlanması veya 

ayarlanması için araçlar sunar. Ayrıca resminizi renk grubundaki renkleri kullanarak yeniden 
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renklendirebilir, çıktı için renklerinizi azaltabilir veya dönüştürebilirsiniz. Seçilen resimdeki 

renkleri içeren yeni bir renk grubu oluşturabilirsiniz.  

 

“Araçlar” panelinde veya “Renk” panelinde “Dolgu veya Kontur Rengi Seçim 

Kutusu”nu çift tıklayınız. 

 

 

Resim 2.23: Renk seçici 

 

 

 Seçicide görüntülenen renk tayfını değiştirme  

 Bir harfi tıklayınız: H (Ton), S (Doygunluk), B (Parlaklık), R (Kırmızı), 

G (Yeşil) veya B (Mavi) 

 

 Renk tayfı yerine renk örneklerini görüntüleme  

 “Renk Örnekleri”ni tıklayınız. Renk tayfını görüntülemeye geri dönmek 

için “Renk Modelleri”ni tıklayınız. 

 

 Renk seçiciyi kullanarak renk seçme  

 

Aşağıdakilerden istediğinizi yapınız: 

 Renk tayfının içini tıklayınız veya sürükleyiniz. Dairesel bir işaret, rengin 

tayf içindeki konumunu gösterir. 

 Renk kaydırma çubuğundaki üçgenleri sürükleyiniz veya renk kaydırma 

çubuğunun içini tıklayınız. 

 Metin kutularına renk değerlerini giriniz. 

 “Renk Örnekleri”ni tıklayınız, bir renk örneği seçiniz ve “Tamam” 

düğmesini tıklayınız. 
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 Renk paneline genel bakış 

 

Bir nesnenin dolgusuna ve konturuna renk uygulamak için renkleri düzenlemek ve 

karıştırmak için “Renk” panelini (Pencere > Renk) kullanırsınız. Renk panelinde renk 

değerleri, farklı renk modelleri kullanılarak görüntülenebilir. Varsayılan değer olarak renk 

panelinde sadece en yaygın kullanılan seçenekler görünür durumdadır. 

 

Aşağıda temel şekiller renk paneli örneğinde; “A. Dolgu rengi, B. Kontur rengi, C. 

panel menüsü, D. Yok kutusu, E. Renk tayfı çubuğu, F. Renk tayfı kaydırma çubuğu, G. Bir 

renk bileşeninin metin kutusu”dur. 

 

 

 

Resim 2.24: Temel şekiller aracı renk paneli   

 

 Renk modelini değiştirme  

 Gri Tonlama, RGB, HSB, CMYK veya Web Uyumlu RGB’yi seçiniz. 

 

 Paneldeki bütün seçenekleri gösterme  

 “Panel” menüsünden “Seçenekleri Göster”i seçiniz. Bunun yerine panelin 

sekmesindeki çift üçgeni tıklayarak da görünüm boyutları arasında geçiş 

yapabilirsiniz. 

 

 Renk panelini kullanarak renk seçme  

 “Panel” menüsünde kullanmak istediğiniz renk kodunu seçiniz. Seçtiğiniz 

renk, renk panelinin görünümünü etkiler, belgenin renk kodunu 

değiştirmez. 

 Aşağıdakilerden birini yapınız: 

 

o Bir kaydırıcıyı sürükleyiniz veya kaydırma çubuğunun içini 

tıklayınız. 

o Diğer kaydırıcıları da onunla birlikte kaydırmak için bir renk 

kaydırıcısını sürüklerken “Shift” tuşunu basılı tutunuz (HSB 
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kaydırıcıları dışında). Böylece aynı rengi korumuş ama tonunu 

veya yoğunluğunu değiştirmiş olursunuz. 

o İstediğiniz metin kutularına değerleri giriniz. 

o Panelin alt tarafındaki  “Renk Tayfı”nı tıklayınız. Hiçbir 

rengi seçmemek için renk çubuğunun solunda “Yok”u tıklayınız; 

beyazı seçmek için renk çubuğunun sağ üst köşesindeki beyaz renk 

örneğini tıklayınız, siyahı seçmek için renk çubuğunun sağ alt 

köşesindeki siyah renk örneğini tıklayınız. 

 

 Renk örnekleri paneline genel bakış 

 

Tüm belge renklerini, degradelerini ve desenlerini denetlemek için “Renk Örnekleri” 

panelini (Pencere > Renk Örnekleri) kullanırsınız. Hızlı erişim için bu ögelerden herhangi 

birini adlandırıp saklayabilirsiniz. Seçili bir nesnenin dolgusu veya konturu, renk örnekleri 

panelinden uygulanmış bir renk, degrade, desen veya renk tonu içeriyorsa uygulanan renk 

örneği, renk örnekleri panelinde vurgulanır.  

 

Aşağıda renk örnekleri panelinde; “A. Spot Renk, B. Global Renk, C. Yok Dolgu veya 

Konturu, D. Çakıştırma Renk Örneği (Bütün kalıplarda basılır.), E. CMYK sembolü (belge 

CMYK modunda açıldığında), F. RGB sembolü (belge RGB modunda açıldığında), G. Renk 

Örneği Kitaplığı Menüsü Düğmesi, H. Renk Örneği Çeşitleri Menüsü Düğmesi, I. Renk 

Örneği Seçenekleri Menüsü düğmesi, J. Yeni Renk Grubu Düğmesi, K. Yeni Renk Örneği 

Düğmesi”dir. 

 

 

Resim 2.25: Renk örnekleri paneli  

 

 



 

 58 

2.8. Örnek Yüzey Düzenleme Çalışmaları 
 

 

Resim 2.26: Yüzey düzenleme çalışması 
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Resim 2.27: Yüzey düzenleme çalışması 

 

Resim 2.28: Yüzey düzenleme çalışması 



 

 60 

2.9. Dosya Kayıt 

 
 “Dosya > Kaydet > Farklı Kaydet > Kopyasını Kaydet”i seçiniz. 

 Bir dosya adı yazınız ve dosya için bir konum seçiniz. 

 

Not: “Farklı Kaydet ve Kopyasını Kaydet” iletişim kutularında format 

seçeneklerinden birini seçiniz. 

 

 Dosya biçimi olarak “Illustrator (*.AI)” seçip “Kaydet” düğmesine tıklayınız. 

 Illustrator uygulamasının önceki sürümleriyle uyumlu bir dosya oluşturmak için 

“Illustrator Seçenekleri” iletişim kutusunun üst kısmında “Sürüm” seçeneğini 

ayarlayınız. 

 "Illustrator Seçenekleri” iletişim kutusunda istediğiniz seçenekleri belirleyip 

“Tamam” düğmesine tıklayınız. 

 

Resim kaydettiğinizde veya dışa aktardığınızda “Illustrator” uygulaması, resim 

verilerini bir dosyaya yazar. Verilerin yapısı, seçtiğiniz dosya formatına bağlıdır. Resmi 

kaydedebileceğiniz dört temel dosya formatı vardır: “AI, PDF, EPS ve SVG” olan bu 

formatlara “yerel formatlar” denir. Çünkü bunlar bütün Illustrator verilerini koruyabilir (PDF 

ve SVG formatlarında bütün Illustrator verilerini korumak için “Illustrator Düzenleme 

Özelliklerini Koru” seçeneğini işaretlemeniz gerekir.). Illustrator uygulamasının dışında 

kullanmak üzere resimleri çok çeşitli dosya formatlarında dışa aktarabilirsiniz. Bu formatlara 

“yerel olmayan formatlar” denir. Çünkü dosyayı “Illustrator” uygulamasında tekrar 

açtığınızda “Illustrator” uygulaması verilerin hepsini alamaz. Bu nedenle oluşturmayı 

tamamlayana kadar resmi “AI” formatında kaydetmeniz, sonradan resmi istediğiniz formatta 

dışa aktarmanız önerilir. 

 

Not: Bağlantılı EPS dosyaları içeren resimleri kaydederken bu dosyalar ikili formatta 

(örneğin, photoshopun varsayılan EPS formatında) kaydedilmişse bir hata mesajı 

alabilirsiniz. Bu durumda EPS dosyalarını ASCII formatında yeniden kaydediniz, bağlantılı 

dosyaları “Illustrator” resmine gömünüz, resmi EPS formatı yerine AI veya PDF formatında 

kaydediniz. 
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UYGULAMA FAALİYETİ 
Aşağıdaki işlemleri tamamladığınızda vektörel çizim programında temel formlardan 

yeni formlar oluşturmuş ve tasarı ilkelerine (egemenlik, koram, tam tekrar vb.) göre bir 

düzenleme oluşturmuş olacaksınız. 

 

Kullanılacak araç gereçler:  

 
 Bilgisayar 

 Tarayıcı 

 Yazıcı 

 

İşlem Basamakları Öneriler 

 Vektörel programda geometrik form çizimleri yapmak 

için bilgisayarınızda programınızı açınız. 

 Atölye önlüğünüzü 

giymeyi unutmayınız. 

 

 Ekranınızın sol üst köşesinde bulunan “File” 

sekmesinin alt seçeneklerinden biri olan “New”i 

tıklayarak yeni bir doküman açınız. 

 Çalışma dokümanınıza 

isim vermeyi unutmayınız. 

 İlk önce “Elips Tool” ile siyah dolgulu bir daire 

oluşturunuz. 

 
 

 

 

 Daha sonra çokgen “Tool” ile siyah dolgulu bir üçgen 

çizerek daire üzerinde çıkarma işlemi yapmak 

istediğiniz şekilde yerleştiriniz. 

 

UYGULAMA FAALİYETİ 
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 Daire ve üçgeni beraber seçerek şekil modlarından 

“Minus Front” kullanarak daireden üçgen şeklini 

çıkartınız. 

 
 

 

 “Elips Tool” ile yeni bir siyah dolgulu bir daire 

oluşturunuz. 

 Daha sonra “Dikdörtgen Tool” ile “Shift”e basarak 

siyah dolgulu bir kare çizerek daire üzerinde çıkarma 

işlemi yapmak istediğiniz şekilde yerleştiriniz.  

 Daire ve kareyi beraber seçerek şekil modlarından 

“Minus Front” kullanarak daireden kare şeklini 

çıkartınız. 
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 Kare ile eksiltme yaptığınız daire üzerine siyah 

dolgulu bir üçgen çiziniz. 

 
 

 Çizdiğiniz üçgeni daire üzerinde ekleme işlemi 

yapmak istediğiniz şekilde yerleştiriniz. 

 

 Eksiltme yaptığınız daire ve üzerine çizdiğiniz üçgeni 

beraber seçerek şekil modlarından “Unit” kullanarak 

daire ve üçgen şekillerini birleştiriniz. 
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 “Elips Tool” ile yeni bir siyah dolgulu daire 

oluşturunuz. 

 Çizdiğiniz dairenin altına ve üstüne aynı boyutta iki 

adet daire çiziniz. 

 
 

 

 Ortadaki daire ile aşağıdaki daireyi beraber seçerek 

yol bulucu komutlarından “Trim” aracını kullanarak 

daireden daire şeklini kesiniz. 
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 Aynı işlemi yukarıdaki daireye de yaparak çizgi ile 

bölme işlemi yapınız. 

 
 

 Trim yapılacak şeklin yani 

kesilmek istenen şeklin 

üstte olması gerekir, 

unutmayınız. 

 Daire için yaptığınız tüm işlemleri sırasıyla temel 

formları kullanarak sırasıyla kare için de yapınız. 
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 Daire için yaptığınız tüm işlemleri sırasıyla temel 

formları kullanarak sırasıyla üçgen için de yapınız. 
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 Oluşturduğunuz yeni formlardan birini seçerek temel 

tasarım ilkelerinden biri olan tam tekrar ilkesine uygun 

bir düzenleme oluşturunuz. 

 

 Bunun için yatay bir A4 sayfa açınız. 

 “Görünüm (View)” menüsünden “Show Grid” 

sekmesini işaretleyiniz. 

 Seçtiğiniz formu açtığınız sayfaya yerleştiriniz. 

  

 

 “Reflect” aracını kullanarak seçtiğiniz formu 

çoğaltarak yansımasını alınız. 
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 Oluşan iki formu beraber seçip önce grup yaparak 

“(Ctlr+G)” tekrar yansımasını alınız. 

  

 

 Oluşan formu grup “(Ctlr+G)” yapıp tüm sayfaya 

çoğaltarak (Çoğaltma işlemini yaparken formu seçip 

“Alt” basılıyken sürükleyerek çekmeniz yeterlidir.) 

yapıştırınız. 

  

 Çoğaltma yaparken oluşan 

formları beraber seçerek 

grup yaparak daha kolay 

çoğaltma yapabilirsiniz, 

unutmayınız. 
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 Dosyanızı kaydediniz ve çıkış alınız. 
 Dosyanızı uygun formatta 

kaydetmeyi unutmayınız. 
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ÖLÇME VE DEĞERLENDİRME 
UYGULAMALI TEST 

A4 alan içine kompozisyon kurallarına uygun, geometrik formlarla hazırladığınız 

çalışmanızı aşağıdaki değerlendirme ölçütlerine göre değerlendiriniz. 

 

KONTROL LİSTESİ 

 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Bilgilerinizi gözden geçirdiniz mi?   

2. Vektörel çizim programını açtınız mı?   

3. Çalışma alanınızı açtınız mı?   

4. Cetvellerinizi açtınız mı?   

5. Kılavuz çizgilerinizi yerleştirdiniz mi?   

6. Şekilleri uygun araçları kullanarak çizdiniz mi?   

7. Çizilen şekillere dolgu rengi belirlediniz mi?   

8. Şekillendirme araçlarını kullandınız mı?   

9. Kompozisyon ilkelerine dikkat ettiniz mi?   

10. Çalışmanızı siyah beyaz olarak çalıştınız mı?   

11. Kullandığınız tüm araçların farklı seçeneklerini denediniz mi?   

12. Zamanı verimli kullanmaya dikkat ettiniz mi?   

13. Çalışmanızdan memnun kaldınız mı?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise bir sonraki öğrenme faaliyetine geçiniz. 

 
 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–3 
 

 

 

 

Bu faaliyette verilecek bilgiler doğrultusunda uygun ortam sağlandığında vektörel 

çizim programında basit metin oluşturabileceksiniz. 
 

 

 

 

 

 Görsel yayınlardaki metin düzenlemelerini inceleyiniz. 

 

3. VEKTÖREL PROGRAMDA METİN 

DÜZENLEME 
 

3.1. Nokta Metin Oluşturma 
 

Nokta yazısı, tıkladığınız yerden başlayan ve siz karakterleri girdikçe genişleyen yatay 

veya düşey bir metin satırıdır. Her metin satırı bağımsızdır; siz düzenledikçe satır genişler 

veya daralır ama sonraki satıra atlamaz. Bu şekilde metin girmek ve resminize birkaç kelime 

eklemek için yararlıdır. 

 

 

Resim 3.1: Nokta metni oluşturma 

ÖĞRENME FAALİYETİ–3 

AMAÇ 

ARAŞTIRMA 
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3.2. Alan Metni Oluşturma 
 

Alan metni (Paragraf metni de denir.), karakterlerin yatay veya düşey olarak akışını 

kontrol etmek için bir nesnenin sınırlarını kullanır. Metin bir sınıra ulaştığında tanımlanan 

alana sığacak şekilde otomatik olarak sarılır. Bu şekilde metin girmek ve broşürlerde olduğu 

gibi bir veya birden çok karakter oluşturmak istediğinizde yararlıdır. 

 

Bir alana veya bir yol üzerine sığmayacak kadar fazla metin girdiğinizde sınırlayıcı 

alanın alt tarafına doğru bir artı sembolü (+) belirir. Taşan metni görüntülemek için metin 

alanını yeniden boyutlandırabilir veya yolu genişletebilirsiniz. Ayrıca metni başka bir 

nesnenin içine de akıtabilirsiniz. 

 

Alan yazısı oluşturmak için: 

 

Çalışma alanında araç kutusundan herhangi bir çizim aracını seçebilirsiniz. Aşağıdaki 

resimde elips seçilmiştir. 

 

Araç kutusundan “Area Type Tool”u seçiniz ve alanın içine fare ile tıklayınız. 

İstenirse alan içine yazı yazılır veya seçilmiş bir yazı kopyalanır. 

 

 

Resim 3.2: Alan metni oluşturma 

 

3.3. Temel Karakter Ayarlarını Uygulama 
 

Vektörel programda yazdığınız yazıların font karakterini, stilini ve boyutunu 

değiştirebilir ayrıca satır ve harfler arasındaki boşlukları ayarlayabilirsiniz. 
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“Paragraf paneli (Pencere > Yazım > Paragraf)”, sütunların ve paragrafların formatını 

değiştirmek için kullanılır. “Yazı” seçiliyken veya yazım aracı etkinken paragrafları 

formatlamak için “Kontrol” panelindeki seçenekleri de kullanabilirsiniz. 

 

A. Hizalama ve Bloklama  

B. Sol Girinti  

C. İlk Satırda Soldaki Girinti  

D. Paragraftan Önce Boşluk  

E. Tireleme  

F. Sağ Girinti 

G. Paragraftan Sonra Boşluk 

 

 

Resim 3.3: Paragraf paneli 

 

“Kontrol” panelinin de yazı ile ilgili panelinde; “A. Font, B. Font Stili, C. Font 

Boyutu, D. Sola Hizala, E. Ortala, F. Sağa Hizala” seçenekleri yer alır. 

 

 

 

Resim 3.4: Paragraf paneli 

 

Varsayılan değer olarak paragraf panelinde sadece en yaygın kullanılan seçenekler 

görünür durumdadır. Bütün seçenekleri göstermek için panel menüsünde “Seçenekleri 

Göster”i seçiniz.  

 

Alan metni ve yol üzerindeki yazı, yazı yolunun bir kenarına veya her iki kenarına 

birden hizalanabilir. 
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Değiştirmek istediğiniz nesneyi seçiniz veya imleci, değiştirmek istediğiniz paragrafa 

yerleştiriniz. Bir yazım nesnesi seçmezseniz veya imleci bir paragrafa yerleştirmezseniz 

hizalama, oluşturacağınız yeni metinlere uygulanır. 

 

“Kontrol” panelinde veya “Paragraf” panelinde bir “Hizalama” düğmesini tıklayınız. 

 

 Sözcük ve harf aralıklarını ayarlama  

 

Vektörel programda harfler ve sözcükler arasındaki boşlukları nasıl ayarlayacağınızı 

ve karakterleri nasıl ölçeklendireceğinizi tam olarak denetleyebilirsiniz.  

 

 Metne girinti ekleme 

 

Girinti, metinle yazı nesnesinin sınırları arasındaki boşluk miktarıdır. Girintiler, 

sadece seçili paragrafı veya paragrafları etkiler. Dolayısıyla farklı paragraflar için kolaylıkla 

farklı girintiler belirleyebilirsiniz. Girintileri; sekmeler panelini, kontrol panelini veya 

paragraf panelini kullanarak ayarlayabilirsiniz. Alan metniyle çalışırken girintileri, sekmeleri 

kullanarak veya yazım nesnesinin iç metin boşluğunu değiştirerek de denetleyebilirsiniz. 

 

 Paragraf panelini kullanarak girintileri ayarlama  

 

 Yazım aracını kullanarak  girinti eklemek istediğiniz paragrafı 

tıklayınız. 

 “Paragraf” panelinde uygun girinti değerlerini ayarlayınız. Örneğin, 

aşağıdakileri yapınız: 

o Paragrafın tamamına bir pika girinti eklemek için sol girinti 

kutusuna  bir değer (1p) yazınız. 

o Bir paragrafın sadece ilk satırına girinti eklemek için ilk satırda 

 soldaki girinti kutusuna bir değer (1p) yazınız. 

 

 Paragraf aralığını ayarlama 

 

 İmleci, değiştirmek istediğiniz paragrafın içine yerleştiriniz veya bütün 

paragrafları değiştirmek için bir yazım nesnesi seçiniz. İmleci bir 

paragrafa yerleştirmezseniz veya bir yazım nesnesi seçmezseniz ayar 

oluşturacağınız yeni metinlere uygulanır. 

 “Paragraf” panelinde paragraftan önceki  ve sonraki  boşluğu 

ayarlayınız. 

 

Not: Bir paragraf sütunun en üstünde başlıyorsa paragraftan önce fazladan boşluk 

eklenmez. Bu durumda paragrafın ilk satırının satır aralığını artırabilir veya yazım 

nesnesinin iç metin boşluğunu değiştirebilirsiniz. 
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 Metin alma 

 

“File (Dosya) > Place”i (Yerleştir) seçiniz. İçe aktarmak istediğiniz metin dosyasını 

seçiniz ve “Place” düğmesine tıklayınız. 

 

3.4. Yol Üzerine Metin Yazma 
 

Çizilen bir yol üzerine metin yazmak için öncelikle çalışma alanına “Pen” aracı ile yol 

çizilir. Araç kutusundan “Type On a Path Toll” aracı seçilir, çizginin üzerine tıkladığınızda 

fare imlecinin yol üzerinde olduğunu görürsünüz. Metni yazdıktan sonra istenirse yazı 

puntosu ve karakteri değiştirilebilir. Yol üzerindeki seçimi kaldırdığınızda çizgi görünmez 

olur. Seçim aracı ile yazıyı seçtiğinizde sağda ve solda beliren işaretlerle metni yol üzerinde 

istediğiniz yere sürükleyebilirsiniz. 

 

 

Resim 3.5: Yol üzerine metin yazma 

 

3.5. Metni Anahtara Dönüştürme 
 

Amblem ve logo çalışmalarında harfler üzerinde değişiklik yapmak için yazıyı resme 

(anahtara) dönüştürmek gerekir. Bunun için yazıyı yazdıktan sonra menüden “Type > 

Create Outline” işlemi uygulanır. Yazı resme dönüştükten sonra araç kutusundan “Direct 

Selection Tool” ile değişiklik yapmak istediğiniz harfi seçersiniz ve istediğiniz değişikliği 

yaparsınız. 
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Resim 3.6: Metni resme çevirme 
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UYGULAMA FAALİYETİ 
Aşağıdaki işlemleri tamamladığınızda vektörel programda metin yazma ve metin 

düzenleme, tasarım ögeleri kullanarak kurallarına uygun bir tasarım yapmış olacaksınız. 
 

Kullanılacak araç gereçler: 

 

 Bilgisayar 

 Tarayıcı 

 Yazıcı 
 

İşlem Basamakları Öneriler 

 Vektörel programda geometrik form çizimleri 

yapmak için bilgisayarınızda programınızı açınız. 

 Atölye önlüğünüzü giymeyi 

unutmayınız. 

 Ekranınızın sol üst köşesinde bulunan “File” 

sekmesinin alt seçeneklerinden biri olan “New”i 

tıklayarak yeni bir doküman açınız. 

 Çalışma dokümanınıza isim 

vermeyi unutmayınız. 

 “Type Tool” ile yazınızı yazınız. Bu yazı tipi için 

“Arial” fontu kalın yazı olarak kullanınız, 

puntosunu ise 150 olarak belirleyiniz. 

  

 

 “Selection tool (V)” ile “Text”i seçiniz. Dolgu 

rengi olarak beyaz, stroke (Çizgi) rengi olarak 

mavi renk tonunu seçiniz. 

 

 

 Daha sonra “Ctrl + C (Copy)” ile kopyaladığınız 

yazıyı “Ctrl + F (Paste)” ile tekrar üzerine 

yapıştırınız. “Stroke – None, Fill – mavi” olarak 

ayarlayınız. 

 

UYGULAMA FAALİYETİ 
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 Seçimi kaldırmadan “Effect – Stylize – Scribble” 

komutunu uygulayınız. Örnek resimde 

gördüğünüz değerleri uygulayınız ve 

onaylayınız. 

  

 

 Bir sonraki adım olarak kelimelerin üstüne ve 

altına “LineTool (Çizgi)” aracını kullanarak çizgi 

çiziniz. Çizgi rengini mavi, “Stroke (Kalınlık)” 

ise 7 pt olarak ayarlayınız. İlk çizdiğiniz çizgiden 

üç kere kopyalayıp oluşturduğunuz çizgileri, 

kelimelerin altına ve üstüne yerleştiriniz. Değişik 

efektler oluşturmak için bazı çizgileri 

daraltabilirsiniz.  

  

 Çizgi aracı ile düz çizgi 

çizebilmek için “Shift” tuşuna 

basılı tutmayı unutmayınız. 

 “Pen Tool (Kalem)” aracını kullanarak resimdeki 

gibi 5 pt kadar çizgi çiziniz. “Symbols Palet”i 

açıp paletin üst sağ tarafındaki küçük üçgenden 

“Symbols” menüsüne giriniz. “Open Symbol 

Library”den (Simgeler Kütüpanesi) “Arrows 

 Mausunuzu araçların üzerine 

getirdiğinizde araç isimleri 

belirir, unutmayınız. 
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(Oklar)”, oklar paletinden de üçüncü şekli 

(Arrow 3) seçiniz.  

  
 Seçtiğiniz ok simgesini üzerine gelip “mouse” ile 

tutarak çalıştığınız alanın üzerine getiriniz. Daha 

sonra getirdiğiniz sembol seçimini kaldırmadan 

sembol paletinde “Break Link”i tıklayınız. 

  
 “Object” menüsünden “Expand Appearance” 

seçeneğine tıklayarak seçtiğiniz ok sembolünü, 

obje olarak tanımlayınız. Mavi renk tonu vererek 

tasarımınıza göre ölçülerini değiştiriniz. 

 

 Oluşan şekli daha önce çalıştığınız text üzerine 

yerleştiriniz. “Selection Tool (Seçim Aracı)” ile 

seçip ölçülerini değiştirebilirsiniz. Tasarımınıza 

göre birkaç tane rakam veya noktalı çizgi 

ekleyebilirsiniz.  
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 Eklediğiniz şekillere “Stroke Paleti”nden de 

oklar ekleyerek tasarımınızı tamamlayabilirsiniz. 

 “Stroke Paneli” size yardımcı 

olacaktır, unutmayınız. 
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ÖLÇME VE DEĞERLENDİRME 
KONTROL LİSTESİ 

 
Bir kelime veya cümleyi vektörel programda yazarak resme çevirme işlemi yapınız. 

Yazı üzerinde kompozisyon kurallarını dikkate alarak ve değişiklik yaparak belirlenen 

ölçüdeki yüzey içine düzenleme yapınız. Çalışmanızı aşağıdaki değerlendirme ölçütlerine 

göre değerlendiriniz. 

 
Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadıklarınız için Hayır kutucuklarına  ( X ) işareti koyarak öğrendiklerinizi 

kontrol ediniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Bilgilerinizi gözden geçirdiniz mi?   

2. Vektörel çizim programını açtınız mı?   

3. Çalışma alanınızı açtınız mı?   

4. Metninizi yazdınız mı?   

5. Metninizin yazı karakterini belirlediniz mi?   

6. Metninizin puntosunu belirlediniz mi?   

7. Metninizde kullanacağınız renkleri (dolgu ve çizgi) belirlediniz mi?   

8. Metninize çizgi kalınlığı belirlediniz mi?   

9. Metni resme dönüştürme işlemini yaptınız mı?   

10. Metin üzerinde kompozisyon kurallarını dikkate alarak değişiklik 

yaptınız mı? 
  

11. Dosyanızı kaydederek çıkış aldınız mı?   

12. Zamanı verimli kullanmaya dikkat ettiniz mi?   

13. Çalışmanızdan memnun kaldınız mı?   

 

 

DEĞERLENDİRME 

 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetlerini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Modül Değerlendirme”ye geçiniz. 

 

ÖLÇME VE DEĞERLENDİRME 
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MODÜL DEĞERLENDİRME 
 

Modül sonunda kazandığınız yeterliği aşağıdaki uygulamayı yaparak değerlendiriniz. 

 

Temel Tasarım dersi Tasarı İlkeleri modülünde öğrendiğiniz uygulamalardan 

(egemenlik, koram, tam tekrar vb.) yola çıkarak bir kompozisyon tasarlayıp (Temel tasarım 

dersinde yaptığınız kompozisyon çalışmalarından bir tanesini de kullanabilirsiniz.) vektörel 

çizim programında çizip renklendirerek çalışmanızı aşağıdaki değerlendirme ölçütlerine göre 

değerlendiriniz. 

 

KONTROL LİSTESİ 
 

Bu modül kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadıklarınız için Hayır kutucuklarına  ( X ) işareti koyarak öğrendiklerinizi 

kontrol ediniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Bilgilerinizi gözden geçirdiniz mi?   

2. Temel Tasarı İlkeleri modülünü gözden geçirerek 

hazırlayacağınız kompozisyonu belirlediniz mi? 
  

3. Vektörel programda geometrik form çizimleri yapmak için 

bilgisayarınızda programınızı açtınız mı? 
  

4. Ekranınızın sol üst köşesinde bulunan “File” sekmesinin alt 

seçeneklerinden biri olan “New”i tıklayarak yeni bir doküman 

açtınız mı? 
  

5. “View” sekmesinin alt seçeneklerinden cetvellerinizi açtınız 

mı? 
  

6. Çiziminizin düzgün olması için cetvelinizin kılavuz çizgilerini 

yerleştirdiniz mi? 
  

7. Program çalışma alanında ekranınızın sol tarafındaki “Araçlar 

Kutusu”ndan temel şekilleri seçtiniz mi? 
  

8. “Görünüm” menüsünden çizgi ve dolgu ayarlarını yaptınız mı?   

9. Kapalı çizimlere dolgu rengi belirlediniz mi?   

10. “Şekillendirme araçları”nı kullandınız mı?   

11. “Pathfinder” menüsünden “Şekil Modları”nı kullandınız mı?   

12. “Pathfinder” menüsünden “Yol Bulucu Komutları”nı kullandınız 

mı? 
  

MODÜL DEĞERLENDİRME 
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13. Kullandığınız tüm araçların farklı seçeneklerini denediniz mi?   

14. Hazırladığınız kompozisyonu renklendirdiniz mi?   

15. Çizgilerde oklar kullanarak farklı tasarımlar denediniz mi?   

16. Dosyanızı kaydettiniz mi?   

17. Çıkış alarak yaptığınız tasarımı incelediniz mi?   

18. Zamanı verimli kullanmaya dikkat ettiniz mi?   

19. Çalışmanızdan memnun kaldınız mı?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise bir sonraki modüle geçmek için öğretmeninize başvurunuz. 
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 Adobe Illustrator CS4 Kullanıcı El Kitabı 
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